AVR-8-bit-Mikrocontroller
Gruppe 200 - Einsetzen von AVR-Tools
Teil 206 - C-Compiler und AVR Studio

Teil 201 - Experimentierboards

1 Experimentierboards zum Testen und Programmieren von AVR-Mikrocontroller
1.1 Mit welchen Mitteln AVR-Mikrocontroller programmiert werden
1.2 Starterkit STK500
1.3 Entwicklungs-Tool AVR Dragon
1.4 ATM18-Controllermodul und ATM18-Testboard
1.5 AVR-ALE-Testboard

Teil 202 - ISP-Programmieradapter

2 ISP-Programmieradapter

2.1 ISP Bezogen auf die verschiedenen Schnittstellen
2.1.1 Serielle Schnittstelle
2.1.2 Parallele Schnittstelle
2.1.3 USB-Schnittstelle

2.2 CC2-AVR-Programmer alias USBprog
2.2.1 Aufbau
2.2.2 Arbeitsweise
2.2.3 Firmware-Anderung

Teil 203 - AVR-ALE-Testboard

3 Beschreibung des AVR-ALE-Testboard

3.1 Schaltungsaufbau

3.2 Stromversorgung

3.3 Einsatz verschiedener AVR-Mikrocontroller

3.4 Anzahl LEDs und Tasten

3.5 LCD-Interface und 20x4-LCD
3.5.1 Erzeugung des Enable-Signals fur das LCD
3.5.2 LCD-Backlight

3.6 Ansteuerung von Relais

3.7 RS-232-Schnittstelle

3.8 USART-Testboard-Schnittstelle

Teil 204 - AVR Studio

4 Einsatz des AVR Studio
4.1 AVR Studio installieren
4.2 Testboard und Programmer zusammenschalten
4.2.1 Treiber AVRISP mkll neu installieren
4.3 Starten von AVR Studio
4.3.1 AVR Studio und CC2-AVR-Programmer
4.3.2 Mikrocontroller-Einstellungen im AVR Studio

Teil 205 - Assembler und AVR Studio

5 Assembler und AVR Studio

5.1 Der Ubersetzer (Assembler)

5.2 Ein neues Projekt erzeugen
5.2.1 Der Projekt-Bereich
5.2.2 Bearbeiten der Assemblerdatei
5.2.3 Assemblieren des Quell-Codes

5.3 Simulation des Codes
5.3.1 Programmausfiihrung im Einzelschrittverfahren
5.3.2 Debugger-Stopp-Punkte

5.4 Verandern des Programmtextes
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5.4.1 Uberwachen von Variablen

5.4.2 Anzeigen der Prozessordetails

5.4.3 Speichern des Projekts
5.5 Erzeugen eines weiteren ASM-Projektes im Schnelldurchgang
5.6 Flashen eines ASM-Programms in ein Mikrocontroller ATmega88

Teil 206 - C-Compiler und AVR Studio

6 CodeVisionAVR C-Compiler und AVR Studio
6.1 CodeVisionAVR C-Compiler installieren
6.2 Erzeugen eines C-Projektes
6.2.1 Ein neues Projekt beginnen
6.2.2 Ein C-Projekt konfigurieren
6.2.3 Arbeitsschritte zur Generierung eines C-Projektes
6.3 Einbinden von AVR Studio in den CVAVR
6.4 AVR Studio Debugger fir CVAVR
6.5 Flashen eines C-Programms in ein Mikrocontroller ATmega88

Teil 207 - Editor - UltraEdit

7 Editor - UltraEdit
7.1 Kopf- und FuB-Zeile
7.1.1 Einstellungen fur Assembler-Programme
7.1.2 Einstellungen fur C-Compiler-Programme
7.2. Syntaxhervorhebung (Syntax Highlighting)
7.2.1 AVR-Assembler
7.2.1.1 Syntaxbefehle fir den AVR-Assembler
7.2.1.2 Farben und Schriftstile der Gruppen fiir den AVR-Assembler
7.2.2 CodeVisionAVR C-Compiler
7.2.2.1 Syntaxbefehle fur den CVAVR C-Compiler
7.2.2.2 Farben und Schriftstile der Gruppen fur den CVAVR C-Compiler
7.3 Wortsammlung fur AVR-Assembler
7.4 Wortsammlung fur CodeVisionAVR C-Compiler

Hinweis

Externe Anschaltungen und Hardware-Erweiterungen werden in der Gruppe 400 - ASM-Projekte und
in der Gruppe 600 - C-Projekte detailliert beschrieben.
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6 CodeVisionAVR C-Compiler und AVR Studio

Anmerkungen:

1. Dieser Teil 206 setzt eigentlich Programmierkenntnisse in der Programmiersprache C zur Erzeugung
lauffahiger Programme mit dem CodeVisionAVR C-Compiler voraus. Da hier allerdings nur die Hand-
habung von AVR Studio und das in der Gruppe 500 detailliert behandelten CodeVisionAVR C-Compi-
lers beschrieben werden soll, werden die Schritte anhand eines fertigen kleinen Programms erlautert.

2. Von der Seite http://lehrer.schule.at/Doblinger/files/AVR Studio 4 Tutorial.pdf (die leider nicht
mehr auffindbar ist) sind in diesem Abschnitt einige Anregungen entnommen worden.

6.1 CodeVisionAVR C-Compiler installieren V2.60

Die Installation der Compiler-Version aus dem Download-Center vom www.cczwei.de des ATM18-Pro-
jektes ist nicht unter Windows 7 bzw. Windows 10 lauffahig!

Auch ein neuer Versuch mit CodeVisionAVR Evaluation V2.05.7a von der HP Info Tech-Homepage
http://www.hpinfotech.ro/html/download.htm (nicht mehr existent) fuhrte leider nicht zum vollen Erfolg,
da die Beispielprogramme unter den Einschrankungen der Demoversion nicht lauffahig sind.

Ein "Bettelbrief* an den Hersteller HP Info Tech mit Hinweis auf das ATM18-Projekt

http://www.cczwei-forum.de/cc2/thread.php?threadid=1797

hat dem Verfasser dann eine verbilligte Vollversion V2.60 eingebracht.

ANMERKUNG (Stand 27.07.2017): In der Zwischenzeit sind einige spéatere Versionen erschienen, die
hier NICHT behandelt werden! Die Versionen ab V3.0 wiirden eine vollstandige Uberarbeitung der
Gruppe 200 - Einsetzen von AVR-Tools notwendig machen (z.B. AVR-Studio).

TROST: Fur den ATMega88 funktioniert die Programmierung auch weiterhin vorziglich. Inzwischen
wurde die Version unter Windows 10 installiert und lauft auch dort bisher einwandfrei.

Nach dem Download steht die Datei setup.exe zur Verfiigung. Bei der Installation wird man sogar
gefragt, ob man Deutsch als Sprache wiinscht. Allerdings wird der Wunsch spater nicht mehr erfillt!

(5]

Willkommen zum CodeVisionAVR C
Compiler Setup-Assistenten

Dieser Assistentwird jetzt CodeVisionAVR V2.60 auf lhrem
Computer installieren.

Sie sollten alle anderen Anwendungen beenden, bevor Sie mit dem
Setup fortfahren.

"Weiter" zum Fortfahren, "Abbrechen” zum Verlassen.

ﬂen.er:' Abbrechen

Bild 6.1-01: Begruf3ungs-Fenster vom CodeVisionAVR C-Compiler
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HE! Setup - CodeVisionAVR C Compiler

Lizenzvereinbarung

Lesen Sie bitte folgende, wichtige Informationen bevor Sie fortfahren.

Lesen Sie bitte die folgenden Lizenzvereinbarungen. Benutzen Sie bei Bedarf die
Bildlaufleiste oder driicken Sie die "Bild Ab"-Taste.

SOFTWARE LICENCE ﬂ

The use of CodeVisionAVR indicates your understanding and acceptance of the
following terms and conditions. This license shall supersede any verbal or

prior verbal or written, statement or agreement to the contrary.

If you do not understand or accept these terms, or your local regulations
prohibit “after sale” license agreements or limited disclaimers, you must

cease and desist using this product immediately.

This product is (C) Copyright 1998-2012 Pavel Haiduc and HP InfoTech s.r.l.,
all rights reserved. ;I

/& Ich akzeptiere die Vereinbarung
" Ich lehne die Vereinbarung ab

= Zuriick I%Weiter:a I Abbrechen

&

Bild 6.1-02: Lizenzvereinbarung akzeptieren

Die positive Antwort auf die obligatorische Anfrage nach dem Akzeptieren der Lizenzbestimmungen
wird dann die Installation eingeleitet:

ilgl Setup - CodeVisionAVR C Compiler

Passwort
Diese Installation wird durch ein Passwort geschutzt

Bitte geben Sie das Passwort ein, und klicken Sie danach auf "Weiter". Achten Sie auf korrekte
Grol-/Kleinschreibung.

Passwort

‘gu"uu"uu"uu"uu"u

< Zuruck 42 Weiter = I Abbrechen
N

Bild 6.1-03: Passwort eingeben

Mit jeder neuen Programmversion ist ein neues Passwort beim Installieren einzugeben. Das Passwort
und die Download-Adresse erhalt man per E-Mail vom Hersteller HP Info Tech s.r.l.
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Aus verstandlichen Grinden kann das Setup-Passwort und die Lizenz-Nummer, welche man beim Kauf
erhalt, hier nicht wiedergegeben werden, so dass das entsprechende Meni "ausgepunktet" dargestellt
wird.

i@- Setup - CodeVisionAVR C Compiler

Ziel-Ordner wahlen
Wohin soll CodeVisionAVR C Compiler installiert werden?

Das Setup wird CodeVisionAWVR C Compiler in den folgenden Ordner installieren.

Klicken Sie auf "Weiter", um forzufahren. Klicken Sie auf "Durchsuchen”, falls Sie einen

anderen Ordner auswahlen machten.
Durchsuchen . |

Mindestens 76,8 MB freier Speicherplatz ist erforderlich.

< Zuriick |;Weiter> I Abbrechen |

V

Bild 6.1-04: Installations-Ordner (sollte nicht verandert werden)

Der Ordner c:\cvavr?2 ist sehr wichtig und sollte nicht verschoben werden. Denn an diesem Ort wer-
den auch die Bibliotheken abgespeichert. Sollte der Ordner noch nicht vorhanden sein, so fragt das
Installationsprogramm, ob es den Ordner erstellen soll.

-,lE! Setup - CodeVisionAVR C Compiler

Startmenu-Ordner auswahlen
Wo soll das Setup die Programm-Verknupfungen erstellen?

Das Setup wird die Programm-Verknupfungen im folgenden Startmenu-Ordner
f erstellen.

Klicken Sie auf"Weiter", um fortzufahren. Klicken Sie auf "Durchsuchen”, falls Sie einen

anderen Ordner auswahlen mochten.
Durchsuchen . |

< Zuruck Weiter > | Abbrechen

Bild 6.1-05: Startmeni-Ordner
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Auch der Ordner fur das Startmeni CodeVisionAVR sollte auf seinem vorgesehenen Platz belassen
werden. Man findet die notwendigen Dateien schneller wieder (zum Beispiel):

C:\ProgramData\Microsoft\Windows\Start Menu\Programs\CodeVisionAVR

il.‘_;'-'- Setup - CodeVisionAVR C Compiler

Installation durchfuhren
Das Setup ist jetzt bereit, CodeVisionAVR C Compiler auflhrem Computer zu installieren.

Klicken Sie auf "Installieren”, um mit der Installation zu beginnen, oder auf"Zurick", um lhre
Einstellungen zu uberprufen oder zu andern.

Ziel-Ordner: ;I
cl\cvavr2

Stantmeni-Crdner:
CodeVisionAVR

f o

< Zuriick &Inst&llieren I Abbrechen |

Bild 6.1-06: Installation durchfiihren

12 Setup - CodeVisionAVR

Installiere ___

Warten Sie bitte wahrend CodeVisionAVR C Compiler auf lhrem Computer installiert
wird.

Dateien werden entpackt ...

cl.\examples\USB\AVR270 USB Mouse\series6-hidmouse-2_0_6-doc\docihtmlia00058.himl

|

Abbrechen

Bild 6.1-07: Installation lauft . . .
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Information
Lesen Sie bitte folgende, wichtige Informationen bevor Sie fortfahren.

Klicken Sie auf "Weiter", sobald Sie bereit sind mit dem Setup forizufahren.

Welcome to the CodeVisionAVR C Compiler V2 and the CodeWizard AWVR Automatic -
Program Generator.

The compiler is designed to be used along with the AVR Studio WV4.19, V5.1 or Atmel

Studio 6.0 or later debuggers, which can be downloaded from the ATMEL web site:
www_atmel.com

For JTAGICE 3 programming support to be available, AVR Studio 5.1 or Atmel Studio 6 or
later must be installed.

Details about using CodeVisionAVR with these debuggers are available in the
Help topics:
- CodeVisionAVR IDE|Tools[The AVR Studio Debugger
- CodeVisionAVR C Compiler Reference|Using the AVR Studio 4.19 Debugger
- CodeVisionAVR C Cumpller Reference|Using the AVR Studlu 5.1 and Atmel Studio 6 lI
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Bild 6.1-08: Setup - Wichtige Informationen

Text siehe weiter unten!

(x|

Beenden des CodeVisionAVR C
Compiler Setup-Assistenten

Das Setup hat die Installation von CodeVisionAVR C Compiler auf
Ilhrem Computer abgeschlossen. Die Anwendung kann tber die
installierten Programm-Verknupfungen gestartet werden.

Klicken Sie auf "Fertigstellen”, um das Setup zu beenden.

é? CodeVisionAVR C Compiler starten

< Zuruck ' Fertigstellen |

&

Bild 6.1-09: Vor der Fertigstellung wird noch nach der 8-stelligen License ID zum Aktivieren ge-
fragt. Sollte das Programm bereits auf einem anderen PC aktiviert worden sein, so ist die Akti-
vierung auf diesem anderen PC zu deaktivieren und auf dem neuen PC neu zu aktivieren.

Danach ist die Installation abgeschlossen

Die neue Version wird gleich gestartet:
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CodeVisionAVR

Rapid Application Development

for Atmel AVR Microcontrollers

Version 2.60 Standard

© Copyright 1898-2012 HP InfoTech s.rl

Bild 6.1-10: Man beachte, dass die "Version 2.60 Standard" keine Evaluation (Testversion) ist
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Bild 6.1-11: Erstes Bild nach der Installation (Bildvergré3erung)
Damit ist CVAVR installiert . . .

. und der erste Aufruf sollte ungefahr wie im Bild 6.1-11 aussehen. Bei spateren Aufrufen, wenn
schon mit dem CVAVR "gespielt" worden sein sollte, "erinnert" sich das Tool an die letzte Einstellung
und gibt diese wieder. Wenn man nicht gerade an einem grol3eren Projekt Uber einen ausgedehnten
Zeitraum arbeitet, bei dem diese Verfahrensweise sehr vorteilhaft ist, so wird man sicherlich bei einem
neuen Projekt beginnen wollen. Das Eréffnungsfenster erhalt man nach erstmaligem Aufruf oder allemal
nach File => Close All - es sind jedoch ggf. einzelne Spalten ausgeblendet.

Zum CVAVR ist auch schon viel geschrieben worden, so dass es fast mifig ist, dem noch etwas hin-
zuftigen zu wollen. Aber: Bei der Installation gibt es noch allerlei Kleinigkeiten, auf die es sich lohnt
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hinzuweisen. Der lange Hinweis bei der Installation (Bild 6.1-08: Setup) ist schnell weggeklickt. Er ist
aber in einigen Punkten sehr aufschlussreich und deshalb als Original-Zitat hier zum Nachlesen wie-
derholt:

Welcome to the CodeVisionAVR C Compiler V2 and the CodeWizardAVR Automatic Program
Generator.

The compiler is designed to be used along with the AVR Studio V4.19, V5.1 or Atmel Studio 6.0 or later debuggers, which can
be downloaded from the ATMEL web site: www.atmel.com (man landet neuerdings bei: https://www.microchip.com/)

For JTAGICE 3 programming support to be available, AVR Studio 5.1 or Atmel Studio 6 or later must be installed.
Details about using CodeVisionAVR with these debuggers are available in the Help topics:

- CodeVisionAVR IDE|Tools|The AVR Studio Debugger

- CodeVisionAVR C Compiler Reference|Using the AVR Studio 4.19 Debugger

- CodeVisionAVR C Compiler Reference|Using the AVR Studio 5.1 and Atmel Studio 6 Debuggers and in the chapters: 2.4.1,
3.21 and 3.22 of the CodeVisionAVR User Manual.

1. Installing CodeVisionAVR

If you will use the Compiler under Windows 2000, XP, Vista or Windows 7 you must first install and run it with Administrator priv-
ileges. On subsequent runs under Windows 2000 or XP you may also have Power User privileges.

After installing under Windows 7, right click on the CodeVisionAVR icon and select Properties|Shortcut|Advanced and check
the Run as Administrator check box.

For installing under Windows Vista, the following steps should be performed, having an Administrator account:
- the Windows Vista User Account Control must be disabled using the steps below:

- press the Windows button and click on the Control Panel link

- in the Control Panel window, under the User Accounts and Family Safety, click on the Add or remove user accounts
link

- a new window will open, click on the Go to the main User Accounts page link located at the bottom of the window

- a new window will open, click on the Turn User Account Control on or off link located at the bottom of the window

- in the new window that will open, uncheck the Use User Account Control (UAC) to help protect your computer check
box and press the OK button to confirm

- the computer will have to be restarted for this setting to become effective

- run the CodeVisionAVR setup.exe installer

- after the installation is complete, right click on the CodeVisionAVR icon on the desktop

- select Properties in the popup menu that will open

- a new window called CodeVisionAVR Properties will open

- select the Compatibility tab

- check the Privilege Level|Run this program as an administrator check box and press the OK button to confirm.

2. New features/bug fixes in CodeVisionAVR V2.60

2.1 Compiler

- Added support for the llitek 1LI9325 graphic TFT LCD controller (only for Advanced license).
- Improved the library for the Solomon Systech SSD1289 graphic TFT LCD controller.
- Modified the alphanumeric LCD library (alcd.h) to be compatible with the Novatech NT3881 controller.

2.2 CodeWizardAVR

- Added the possibility to automatically set all the timer configuration registers for user specified operating mode, period and
output duty cycle(s).

- Fixed: the Timer5 OC5A, OC5B, OC5C outputs were assigned to non-existent PORTM, instead of PORTL, for the
ATmega640/1280/2560 chips.

- Fixed: the OC4A, OC4B, OC4C OC5A, OC5B, OC5C outputs are not present for the ATmegal281/2561 chips.

- Fixed: the ADTSO0..3 bits in the SFIOR or ADCSRB registers were not set correctly, when using one of the
ADC auto-trigger modes.

- Fixed: the ADC auto-trigger modes were missing for the ATmega32 chip.

- Fixed: USART code generated for the ATmega64 chip, used UMSEL00..UMSEL11 bit names instead of UMSELO and
UMSEL1 in the UCSROC and UCSRIC registers.

- Fixed: ADC code generated for the ATmega64 chip, used the ADATE bit name, which is not present in the ADCSRA register
of this chip.

2.3 Chip Programmer
- Added check for conflicts between the 'EEPROM|Program' and 'Preserve EEPROM' options.

- Fixed error for restoring EEPROM contents after chip erase, when the 'Preserve EEPROM' option was enabled and
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Atmel Studio 6 was set as debugger.
3. New features/changes in CodeVisionAVR V2.60, not available in old V1.25.x compilers

3.1 Compiler

- ANSI C compatible C front-end

- the bool data type was added (stdbool.h)

- the @ operator can now be used with variables located in EEPROM too

- the & unary operator can now be applied to I/O registers declared using the sfrb and sfrw keywords.

It will return a pointer to the RAM address where these registers are mapped.

- there is no need to specify the ‘flash’ or ‘eeprom’ memory attribute during structure or union type definition. Therefore the
same structure or union data type can be easily located in any memory area during variable declaration.

- the compiler now makes distinction between the ‘const’ type qualifier and the ‘flash’ memory attribute. In order to maintain
compatibility with V1.25.x projects, the Project|Configure|C Compiler|Code Generation|Store Global Constants in
FLASH Memory must be checked. If this option is not checked, identifiers declared with the ‘const’ type qualifier will be placed
in RAM.

- the preprocessor does not use the old ‘funcused’ directive, when it is found it is always evaluated to 1

- added the #message preprocessor directive

- the abs, cabs, labs and fabs functions were moved from the math.h header to the stdlib.h header

- improved error and warning checking

- improved linker: only the modified C source files are compiled when the Project|Build command is executed

- improved COFF object file generator

- improved code optimizer

- enhanced libraries, including MMC/SD/SD HC FLASH Memory Card and FAT support

- I/0 registers bits definitions were added to the device header files.

For projects created with prior versions, these definitions are not enabled by default.

In order to enable them the Project|Configure|C Compiler|Code Generation|Preprocessor|include I/O Registers Bits Definitions
option must be activated.

For newly created projects, this option is enabled by default.

- in order to eliminate naming conflicts with 1/O registers bits definitions, the names of the SPCRO0, SPDRO0, SPSRO registers
were changed to SPCR, SPDR, SPSR in the following header files: megal64.h, mega324.h, mega644.h, mega644p.h.

- in order to eliminate naming conflicts with 1/O registers bits definitions, the names of the PCINTO, PCINT1, PCINT2, PCINT3
interrupt vectors were changed to PC_INTO, PC_INT1, PC_INT2, PC_INT3 in the following header files: 90usb1286.h,
90usb1287.h, 90ush646.h, 90usb647.h, 90usb162.h, 90usb162.h, megal280.h, megal281.h, mega2560.h, mega2561.h,
mega640.h, megal284p.h, megal62.h, megal64.h, megal65.h, megal68.h, megal68p.h, megal69.h, mega324.h,
mega325.h, mega325p.h, mega3250.h, mega3250p.h, mega328p.h, mega329.h, mega329p.h, mega3290.h, mega3290p.h,
mega406.h, mega48.h, mega48p.h, mega644.h, mega644p.h, mega645.h, mega6450.h, mega649.h, mega6490.h, mega88.h,
mega88p.h, tiny10.h, tiny13.h, tiny24.h, tiny25.h, tiny44.h, tiny45.h, tiny48.h, tiny84.h, tiny 85.h, tiny88.h, tiny261.h, tiny461.h,
tiny861.h, tiny2313.h.

If these interrupt vectors are used in your programs, their names must be updated.

- in order to eliminate naming conflicts with 1/O registers bits definitions, the names of the INTO...INT7 interrupt vectors were
changed to EXT_INTO...EXT_INT7 in the following header files: megal280.h, megal281.h, mega2560.h, mega2561.h,
mega640.h, megal284p.h, megal64.h, mega324.h, mega644.h, mega644p.h.

If these interrupt vectors are used in your programs, their names must be updated.

- removed the limitation: when a literal char string enclosed between quotes, is passed as an argument to a function parameter
of pointer to char, the pointer now can point to any memory type: RAM, EEPROM or FLASH, not only FLASH like in previous
versions. The CodeVisionAVR C Compiler Reference|Constants Help topic and User Manual chapter were updated to reflect
this change.

3.2 IDE

- completely redesigned text Editor with improved syntax highlighting for both C and AVR assembly

- added function parameters and global structure/union members auto complete

- improved code folding

- code folding state can be saved and restored

- bookmarks state can be saved and restored

- added automatic matching brace highlighting when the user places the cursor before the brace

- added automatic file saving at specified time interval

- the Code Navigator was redesigned and displays project information in a more logical way

- an additional Code Information tab is present after a project build. It displays detailed information about the included header
files, preprocessor macro definitions, type definitions, global/static variable declarations, memory allocation and function
definitions.

- added the Functions Call Tree tab in the Navigator

- the new Project|Configure|Files|Output Directories allows to specify in which directories the files generated by the
compiler/linker will be placed.

- improved toolbar

It is important to note that in CodeVisionAVR V2 the .asm, .hex, .eep, .cof files created by the compiler have the name of the
project .prj file.

3.3 CodeWizardAVR

- Generates code using symbolic names for peripheral configuration registers' bits.
- Improved user interface.
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4. New ATxmega chips support in CodeVisionAVR

- the Standard C I/O Functions use by default the USARTCO. This can be changed by defining the
_ATXMEGA_USART_ macro as described in the corresponding Help topic.
- the SPI functions use by default the SPIC controller on PORTC. This can be changed by defining the _ATXMEGA_SPI_ and
_ATXMEGA_SPI_PORT_ preprocessor macros as described in the corresponding Help topic.
- the RTC functions do not yet support the ATxmega chips.

5. Example programs

The Compiler is supplied with the following example programs:

- ATxmega chips in \EXAMPLES ATxmega
- Graphic LCDs in \EXAMPLES\Graphic LCD

- SD FLASH Memory Cards access in \EXAMPLES\SDCARD

- USB in \EXAMPLES\USB
- AVR 109 Bootloader
- AES Encryption-Decryption

- "ATmega8535 ADC on the STK500" in \EXAMPLES\ADC8535
- "Real Time Clock with ATmegal03, Atmel Application Note AVR134" in \EXAMPLES\AVR134

- "Calling functions written in assembler from C" in \EXAMPLES\C_ASM

- "Moving LED" in \EXAMPLES\LED

- "Accessing the EEPROM" in \EXAMPLES\EEPROM

- "LCD Demo" in \EXAMPLES\LCDDEMO

- "Definition of user characters in LCDs" in \EXAMPLES\LCDCHAR

- "LM75 Thermometer" in \EXAMPLES\THERM75
- "LCD Thermometer" in \EXAMPLES\THERMLCD

- "DS1820/DS18S20 Multipoint thermometer” in \EXAMPLES\DS1820

- "DS1990 Serial Number iButton” in \EXAMPLES\DS1990

- "AD7896 Digital voltmeter" in \EXAMPLES\SPI

- "MAX1241 Digital voltmeter" in \EXAMPLES\MAX1241

- "4x4 Keypad" in \EXAMPLES\KEYPAD

- "Simple multifile project" in \EXAMPLES\MULTFILE

- "Redirecting the output of standard C 1/O functions to USARTO, USART1

and LCD for an ATmegal28 chip" in \EXAMPLES\2USART_LCD

- Tiny5 Level Meter
- ulP_Crumb644-Net_CVAVR web server
- TWI Master-Slave.

After starting CodeVisionAVR, execute the File|Open menu command and load the Project (*.prj) file for the example you like.
Then execute the Project|Build All menu command to compile and link the project.

Take some time and carefully read the Help.

Auch C-Programme werden ausschlielich in Form von Projekten bearbeitet, so dass jetzt an die Bil-
dung eines C-Projektes herangegangen werden soll.

6.2 Erzeugen eines C-Projektes

M L:\AVR_PB_LED

=1o] x|

[CoRI

ﬂ [i{_]]l AVR_PB_LED durchsuchen

5

| Datei Bearbeiten Ansicht Extras 2

Organisieren ¥  Freigeben fir ¥  Brennen

- Sicherungs-LW 1000 GB (I:) Al

Neuer Ordner

» Wechsel-LW2 160 GB (J:)
- ExtVideo-LW 1000 GB (K:)
> KINGSTON (L:)
| ALEs_ASM_Progs
| . AVR_PB_LED é@
= Wechseldatentrager (M:)
& Netzwerk

[EE Systemsteuerung
5. Papierkorb

=~ 10
Name “ Grobe | Anderungsdatum | Typ |
+ Nicht angegeben (7)
application.c 11KB 15.08.2009 14:17 C compiler source file
application.h 36 KB 15.08.2009 21:34 C compiler header file
iomx8.h 46 KB  15.08.2009 15:08 C compiler header file
macros.h Q 4KB 15.08.2009 20:07 C compiler header file
main.c 6 KB 15.08.2009 21:18 C compiler source file
switches.h 4KB 15.08.2009 20:09 C compiler header file
typedefs.h 9KB 15.08.2009 20:13 C compiler header file

7 Elemente
[

7 Elemente

1A Computer

N

Bild 6.2-01: Einen neuen Projekt-Ordner mit (vorhandenen) Quell-Dateien anlegen
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Im Beispiel wird zur Demonstration einer Projekt-Generierung ein neuer Projekt-Ordner AVR_PB_LED
auf einem USB-Stick KINGSTON (L) angelegt, in dem alle fertigen *.c- und *.h-Dateien des fertigen
Projektes AVR_PB_LED ubertragen werden.

Siehe: Gruppe 600 - AVR C-Projekte, Teil 601 - AVR_PB_LED
Einfache Beschaltung von LEDs und Tastern, der Quell-Code steht unter 601_Projekt AVR_PB_LED

Der Ordner-Name wurde vom Namen des bestehenden Projektes auf der Festplatte entlehnt. Dieser
Ordner und die folgenden Schritte dienen gleichermaf3en zur Demonstration, wie man als "Neuling"
fertig erstellte Projekte zum Testen benutzen kann. Wenn man ein neues Projekt beginnt, fangt man ja
bei "Adam und Eva" an, d.h. man legt einen neuen Projekt-Ordner an, Ubernimmt oder erstellt darin die
Quell-Dateien und marschiert dann durch die hier beschriebenen Instanzen.

6.2.1 Ein neues Projekt beginnen

Oben wurde das Compiler-Tool CodeVisionAVR installiert; jetzt wird das erste Projekt (wenn auch
nur entlehnt) durch Start dieses Tools erzeugt:

J Fi Search View Project Tools Settings Help
[l e MBS, ~ 4 B
= =
lcReopen >I§[ntnotﬂak|o E"@E‘@"@@
| @ save e B BB E .
}E Save AS... 2 2t Code Informa.. % & £4|| %F Function Call Tres
5l save Al Shift+Girl+s
#s Close Gl ﬂ
@ Cloze Multiple .
2 close Al File Type
{~ Source Ok
m Convert to Librany ¢ —
2 Page Setup 0 Project x Cancel |
Brint Freview ———————————
=8 Print Chl+P
1 Exit Alt+F4
E teszages
[="RN=N = T I

Bild 6.2.1-01: CVAVR fir ein neues Projekt starten
File => New => Create New File => Project => OK
BEL
JEiIe Edit Search View Project Tools Settings Help
D2 B0 EE |8 ERE .|| XB|SEE /K% o-0-6 2 |8 B« B,
jan s pu 32200 EEERE|E BN 8k%20. | EaNea. |2 X6,
EE R R EE

E?: Code Mavigatar W & Iil @ Code Informa.. % 5 ﬂ—| %f Function Call Tree 5% ﬂ—| % Code Tem.. & & | -% Cii.. ¥ & ]
=5 CodebisiondR iE 0 { =

= % Mo Project i

e Other Files
8 T

1
™%  ‘fou are about to create a new project.
‘\ /I Do you want to use the CodeWizardAVR?

de 1 —
1

Yee No while ()7
while () {
¥ d

I

for (;7) {

-

E Messages w2 g I§|
E Errors | E Wamingsl

| | |
Bild 6.2.1-02: Anfrage, ob der CodeWizardAVR benutzt werden soll
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Es soll der CodeWizardAVR nicht verwendet werden: => No; es meldet sich das Fenster Create New
Project. Dieses verweist ggf. zundchst auf den Pfad der CVAVR-Installation:

C:\cvavr2\bin

weil der Compiler-Hersteller offenbar davon ausgeht, dass alle Projekte hier konzentriert werden sollen.
Da aber das Projekt in einem eigens daflir vorgesehenen Ordner angelegt werden soll, missen hier
neue Einstellungen vorgenommen werden.

Im Feld Speichern in: wird der neu eingerichtete Ordner gesucht.

Hier: AVR_PB_LED => Speichern

Creteow Prject x x
Speichemin | | bin -l % Ey Speichemin | KINGSTON (1) -] er @
Name X SroBe |V| A Name |V| GroBe
v Es wurden keine Suchergebn'ss!gefunden. / Nicht angegeben (2)
Zule!zt’:jbesucht Zule!zt’:jbesucht | ALES_ASM_Progs
Desktop Desktop
Biblotheken Biblotheken
3 A
Computer Computer
Ll | o Ll | o
Dateiname: | =l Speichen_| Datsiname: | = Offnen
Dateityp: [Projectfiles (*.pr) 4| Abbrechen Dateityp: [Projectfiles (" pr) | Abbrechen
Bild 6.2.1-03: Create New Project Bild 6.2.1-04: Ordner AVR_PB_LED suchen
Klick auf — und KINGSTON (L) wahlen AVR_PB_LED markieren => Offnen

Jetzt muss noch der Dateiname fir das Project file (*.prj) benannt werden. Sinnvoll ist es, den glei-
chen Namen wie fiir den Projekt-Ordner zu wahlen - namlich AVR_PB_LED. Nur diese Datei braucht
spater aufgerufen zu werden, um Anderungen im Projekt vorzunehmen. Sie soll wie folgt abgelegt wer-
den (hier beispielhaft auf dem USB-Stick L:):

L:\AVR_PB_LED\AVR_PB_LED.prj

% a
Speichemin: [ | AVA_PB_LED = e3> E Speichemin: [ | AVA_PB_LED = ed i E
Mame = | +| Graie |- Anderungsdatum |~ Mame = | +| Graie |- Anderungsdatum |~
@ Es wurden keine Suchergebnisse gefunden. @ Es wurden keine Suchergebnisse gefunden.
Zuletzt besucht Zuletzt besucht
Desktop Desktop
Bibliotheken Bibliotheken
A A
Computer Computer
ﬂ ﬂ
Netzwerk Netzwerk
4| | | | S | i
Dateiname: | =l Speichem_| Dateiname: [avm_pe L] ZZ = Speichem
Dateityp: |Project fies (pr) % =l Abbrechen | Dateityp: Proisct fles (" pi) [ Abbrechen |

Bild 6.2.1-05: Es wird eine *.prj-Datei angefordert Bild 6.2.1-06: Benennen der *.prj-Datei

Es o6ffnet sich zusétzlich das Fenster Configure Project AVR_PB_LED.prj mit der Aufforderung, dem
Projekt nun die Quell-Dateien hinzuzuftigen (besser: bekannt zu machen, da sie sich ja bereits im Pro-
jekt-Ordner befinden).
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4 Configure Project AVR_PB_LED.prj

Files |CEOmpiIet| Before Build | After Build |
Input Files I Output Directories |

=
E
I:U
S
ICD
i
m
Z
=
I:D
o
IUJ
—
m
=
T
i)

=

o

=

[x

)

Add
Femove
Edit File Hame

4 Move U

P fove Down

HA»

Add File to Project al x|
Suzhenin: | |, AVR_PB_LED = e =
Name + | =] Grage |=] Anderungsdatum |~
Nicht angegeben (6)
Zuletztbesucht |SEN 18.03.2012 23:47
D | Linker 18.03,2012 23:47
P | List 18.03.2012 23:47
| Obj 18.03.2012 23:47
|| application.c 11KB 15.08.2009 15:17
Bibliotheken | main.c 6KB 15.08.2009 22:18
A
Computer
3
Netzwerk
4] | 2l
Dateiname: | | Ofnen_|
K I X Cancel | 7 Hep | Datetyp: [ Complerfites (") =l Abbrechen

Bild 6.2.1-07: Configure Project Add => Bild 6.2.1-08: Neue Projekt-Struktur
Part 1 - Input Files

Im Hauptfenster von CVAVR sieht man bereits, dass auf der linken Seite im Code Navigator der Pro-
jekt-Name AVR_PB_LED und in der Kopfzeile der Name der Projekt-Datei AVR_PB_LED.prj eingetra-
gen sind.

CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LEQ\prj N =
J_He Edit Search View Project Tools Setfings
Ibe2-BE § o6&

filfRE || imaaXB|EEEs7|%|o-0-88|EBxA|H.
b penm 1R RO0%0EEEE(DHSN. k%00, | HaNsa |2 6.

AT E e B =N

& Code Mavigator % & | % Code Information % # B3|/ %l Function Call Tree 5 &| [ENEEERINGE | = Code Te.. ¥ 3 @ By clip. ¥ 5 &

=5 CodevisionAvR if ()
@ Project AvR_PB_LED 1

[ OtherFil
[ Other Files % T
H

do  {

Bild 6.2.1-09: Hauptfenster von CVAVR

Jetzt missen alle C-Dateien zum Kompilieren und Binden dem Projekt bekannt gemacht werden. Das
Meni lasst automatisch nur C-Dateien zu und weist damit bereits darauf hin, dass nur die C-Dateien
den anfanglichen Start bestimmen. Die Header-Dateien werden erst wahrend der Kompilierung (ge-
nauer: wahrend des Preprozessor-Laufs) aus den C-Dateien heraus aufgerufen und in das Coding ein-
gefigt.
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CodeVisionAVR - J:\AVR_PB_LED\AVR_PB_LED.prj

File Edit Search View Project Tools Settings Help

|
IDea-BEdcdEs 8RS
[eh ity B B D%

|8 55| 1 e EmE = m

[ Cade Navigatar

&7 2R El @ Code Infarma... ©

=5 CodevisionaFi

4 Project AvR_PE_LED
Other Files

E Meszages

E Errors | E Wamingsl

- o x|
oo
Suchenin: [, AVR_PB_LED i [ e S s Bles,
Name = |v| Griifie |v| Anderungsdatum Iv
g Nicht angegeben (6)
Zuletzt besucht |HgYRe. 18.03.2012 23:47 0. v 28
D |\ Linker 18.03.2012 23:47
Desktop L. List 158.03.2012 23:47
| obj 18.03.2012 23:47
E . application.c
Bibliotheken rnairl.l: '\
A /
=
Computer
18
Metzwerk
< | i
w20
Dateiname: I"main.c” "application.c" j g Offnen I |
Dateityp: IC Compiler files *.c) j Abbrechen | |

Bild 6.2.1-10: C-Dateien dem Projekt bekannt machen

Alle C-Dateien auswéahlen => Offnen und . . . . OK im Configure Project-Menii

Achtung: Der Vorgang dauert eine Weile - Bitte nicht die Geduld verlieren!

Noch mal der Reihe nach (wegen der Uberschneidung der Meniis):

Bild 6.2.1-06: Benennen der *.prj-Datei: AVR_PB_LED.prj => Speichern
Bild 6.2.1-09: Hauptfenster von CVAVR - zur Ubersicht
Bild 6.2.1-07: Configure Project - Part 1 (das Meni bleibt zun&chst noch sichtbar) => Add
Bild 6.2.1-08: Neue Projekt-Struktur
Bild 6.2.1-10: C-Dateien dem Projekt bekannt machen => *_C-Dateien markieren => Offnen
Bild 6.2.1-07: Configure Project => OK

Durch OK im Configure Project werden alle *. c-Dateien in das Projekt tibernommen.

CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LED.prj

File Edit Search View Project Tools Settings Help

=1olx|

0 E RS,

o]t BB S|EE /%] 0-0-8 0|8 &~ B[,

J
be-HEdS &S
|

LR - LN ES L AN I NES 2NV NEES ST NI
|JomfE1 e BRaw EEE.
f&: Code Mavigator w & (| B Codel.. ¥ & || % Function Call .. % || IENVEEERE NGl = Code Templ.. ¥ & &||Bxclip. ¥ # 6
=-5% CodevisionAvR Mo if () o =
2 Project AVR_PB_LED e b
©LTE Motes -
[ application.c £ “} ¢
[ main.c
B Headers do { -
- = ListFiles ¥
AR_PBE_LED.asm while ()
B AVR_PB_LED st while () {
: LB AVR_PB_LED.map i
[ OtherFiles
for (;7) { -

H Messages

2 &8

B Erors | B Wamingsl

1:1 Insert
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Bild 6.2.1-11: Hauptfenster von CVAVR
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CodeVisionAVR - J:\AVR_PB_LED\AVR_PB_LED.prj ﬂ _||:|| ﬂ

J File Edit Search View Project Tools Sethngs Help
J Eo-HEdCE
Jw_«.um;m.mn:%n»towo@..@@.@
B e E EEEN

EE 4K |%| 00 thaa

- ||

I ."-\\"R

F: Code Mavigator @V (2 @ Code Informa... % 2 (4| % Function Call Tree 5% 3| [ _% Code Tem.. & 5% _—l -%E‘] Cli... & _I':I—l
=- E\}; CodetfiziondW R vovv if () |
E-[F Project A¥R_PE_LED i
‘ S Mates
—-[Y application.c if () |
-4 main.c 1
- [Bll Headers - -
=l List Files do |
o [B AWR_PB_LED.asm ) 1
B avR_PB_LED while ()
: [ AWR_PB_LED.map while (1 {
----- @ Other Files +i
for i(:;) {
bi
switch () {
cazae :
switch () {
caae o
void main(woid) {
i
H Messages o3 Kﬂ

E Errars | E Warningsl

Bild 6.2.1-12: Die Spalten "Function Call Tree", "Code Templates" und "Clipboard History" wer-
den zunéachst entfernt, um Platz fiir die *.c-Dateien zu erhalten

In der "File Pane" (Editier-Feld, das ist die 4. Spalte von links) - wo bereits die leere *. txt-Datei unter
"Notes" vorgemerkt ist - kdnnen alle *_c-Dateien auch nebeneinander oder untereinander angezeigt
werden. In der AVR_PB_LED. txt-Datei kann das Projekt unter "Notes" detailliert beschrieben werden
- das soll uns hier aber noch nicht interessieren.

Wenn die Felder nicht gleich so erscheinen, wie sie im Bild 6.2.1-12 dargestellt sind, so ist zu bemerken,
dass die Felder - wie in anderen Anwendungen auch - minimiert, maximiert oder "gezogen" werden
kénnen, was hier geschehen ist.

Um Platz fur die Quelldateien zu schaffen, werden jetzt die Spalten Function Call Tree, Code Temp-
lates und Clipboard History zunéchst entfernt (ﬂ vergl. Bild 6.2.1-12) und die "File Pane" verbreitert:

CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LED.prj o x|
J Flle Edit Search View Project Took Settings Help |
= *-*-/Y?K|ﬁ|© o - _..@_>|EB
|88 & w gp Moy .|| & [+
R = == =
. Cade M avigatar w 2 . Rl | \4/P_PE_LEDVAVR_PE_LED bt

= F\VR Y CaodevisionAYR
=-[J Project AVR_PE_LED
@ MNotes

-0 appllcat\on c

@ Headers
. =-[B ListFiles )74
[ AvR_PB_LED.asm 2 @%
B AvP_PB_LED.Ist
! [ AvR_PB_LED.map
L[ OtherFiles

H heszages w2 @
E Errors | E Wamingsl

| |

T | | Insert |

Bild 6.2.1-13: Verbreiterte "File Pane"
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Mit ein wenig Jonglieren werden die Spalten gestaltet:
1. Spalten nebeneinander
2. Offnen von main.c im Code Navigator

3. Offnen von application.cim Code Navigator

Wie man sieht, kann man im groBen Fenster noch eifrig alle Quell-Dateien verandern/editieren. Die
farbliche Kennzeichnung der Syntaxhervorhebung weicht auch hier vom Beispieltext etwas ab, da der
integrierte Editor vom CVAVR fur die Syntaxhervorhebung nicht so viele Einstellméglichkeiten bietet wie
der UltraEdit (siehe Teil 207 Editor - UltraEdit).

GodeigonAVTL1:\AVL_PR_IFD\AVR_PR_1FDar] =l
He Edt soarch wew Pt Toos Semngs e

Beo UEACEED[ARS. - skl B & [%oow-he ERwh

b M“n!ﬂ;ﬂ'i'{‘ﬂﬁﬂﬂ ARFAFE S B, A FVEU. RN N, @,

H Hessegas
3 Eoos | @ Vork]

T3 [ et cole ifrmaion ey be neomgie, i e s ot Lo v

Bild 6.2.1-14: Die *.c-Dateien sind bereit zum Editieren (BildvergroRerung)

CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LED.prj
Jﬂe Edit Search View Project Tools Settings Help

ceg-dEgcEcmERg. | | va|iane BH|EEe 7% % o-o-0 2|8 &« B[,
(s Apam 512 ROL0EEEE S bA. 4% 0. | xakaa. |2 8.
B EE =N

'Ez’}; Code Navigator w2 £
EE\_}‘; CodeVisionAvR

Motes  mainc £

: C;
=3 Project AvF_PB_LED =-Fi} Functions
¢ Notes - app_initfvoid) LR
i application.c -1} app_set_watchdog_prescalel 2
main.c 4
: Headers F) AEEAARERRA Rk b AL A AR kAR A ARk n skt stsskrtnss 501 AVR C Projekt PB LED
(¥ @ List Files E
H "0 AP PE_LED.asm & dkdAE AR h bR Ak b bRk A bbbk A E main, o 4 V1,1 thEEE
[l AYR_PB_LED.Ist g
] B AVR_PE_LED.map 3
@ Other Files 9 Projekt €01..........: Demonstration der Taster und LEDs zuf dem T=stboa.
10 Zusastzliche Header..: keine
a1 Module. (*.c und *.h).: application
12 Bencetigte Hardware..: Testboard, Taster S§1, S2, §3 und LED1, LED2, LED?
13 VErsion.......ovee.aat 1.1
14 Compiler.... : CodeVisionAVR
1 Chip........ : ATmegafg
16 Datum....... : Juni 2008
17 Autor..vssvvuvesavse.i Alwin Lenck (ALEZ3) basiersnd suf dsm Projskt FB .
18

Bild 6.2.1-15: VergroRerung von Bild 6.2.1-14 - Projekt-Stand vor der Kompilierung
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6.2.2 Konfiguration des C-Projektes

Bevor das Programm kompiliert wird, sollen vorher noch einige andere Listen zur Konfiguration des
Projektes genauer betrachtet werden. Dazu wird erst einmal das Konfigurations-Meni erneut aufgeru-
fen:

x|
Files | & Compiler | Bsfors Build | Ater Build |
Input Files OutputDlredUrles@
Executable Files
IExe H
Obiject Files:
[0 H
Ligt Files:
IL\st H
Linker Files
CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LED.prj |Lmker H
J Fle Edit Search View | Project Tools Settings Help
D2 -HEGO B ntax !
[#8 2 1 op 0 [[|°F Comple o
| By | 7 [0 & % Buid Shift+Fo |
o3
[ Code Mavigator £a Buid Al Ctri+F9
=8 CodeVisionAvR | @ 5t0p Compiation
=-[F Project AvR_PE_ %. Clean Up
&) Motes
applicationc @ Iformation
rmain.c
Y Headers B Go toNext Error F8
to Previous Error Ctri+F8
to Next VWarning F4
to Previous Warning  Ciri=F4
<] Notes
G Export
Bild 6.2.2-01: Aufruf des Konfigurations-Menis Bild 6.2.2-02: Configure Project

Part 2 - Output Directories

Project => Configure => Nl LI CALVLIEREZIP DT => Output Directories

In dieser Abbildung werden die Ausgabe-Ordner angezeigt, in denen bei der Kompilierung die Ergebnis-
Dateien abgelegt werden.

Executable Files: = o KINGSTOMN (L:)
* _hex-Dateien vom Linker ALES ASM P
+H 5 4 _Frogs

Object Files: = | AVR PB LED
*_obj-Dateien nach dem Lauf des Assemblers T

| Exe
List Files: | Linker
* _asm-Dateien nach der Kompilierung List
Linker Files: | Obj

*_a- und *.o-Dateien zum Linken/Binden
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4 . Configure Project AVR_PB_LED.prj

'Files  CCompiler | Before Build | Atter Build |

Code Genearation |Libranes| Messagesl Globally#defmel Paths |

é@hlp:l%\TmegaEE ;I

FiAR
Data Stack Size 256 bytes
Clock: |1B,DDDDDD "ZIMHZ
Heap Size: ID bytes

hemary Model: Internal Al Size:  [1024 ytes
ISmaH 'I

Cptimize for:

IS'ZE LI ~Code Generation

Optimization Lewvel:

IMaxlmaI 'l

Frogram Type:

IApphcﬁliDl’] vl

(s)printf Features:

Iint width VI

(s)scanf Features:

Iint wiiclth vl

Bit Warighles S\ze:|1 E - l|_ Lgse GFIOR »31
[~ Pramote charto int
I_ g bit enums |_ Enhanced Far. Passing

[ charis unsigned

v Autormatic Global Begister Allocation

[v Stare Global Constants in FLASH Memary
[~ Use an External Startup Initialization File
[v Clear Glohal Yariahles at Program Startup
[~ Stack End Markers

File Output Format(s) ICOF RO HEX EEF vl

Preprocessor

[ Create Preprcessor Output Files

[v Include /0 Registers Bits Definitions

X Cancel

? Help |

4 . Configure Project AVR_PB_LED.prj

"Files  CCompiler | Before Build | Atter Build |

Code Generationl Libraries Messages |Glabally#deﬁne| Paths |

[# Enable Warnings

WWarnings:

™ constant out of range
[ possible loss of precision
¥ array index is out of range

¥ canstant not initialized

¥ macro was redefined

¥ empty line

! shift resultwill ba 0

L O T R S NN B

¥ Fishd location address is out of range
! interruptvectar exceeds the allowshle range

¥ suspicious pointer conversion
¥ reqister is already allocated

¥/ function must hawe a return value

¥ unused function was removed by the linker

¥/ function parameter was not referenced

¥/ function paramster name doesn't match its previous declaration

¥ lacal variable was declared, but not referenced

¥l local variahle set, but nat used

¥ lacal variable is used befare its value is sat

¥ global variahle/constantwas declared, but nat referenced

¥ lahel declared, but nat raferanced —

|»

¥ expression with possibly no effect
I unknown escape sequence

W overlow is possible in § bit addition

¥ overflow is possible in & hit multiplication
V¥ overlow is possikle in 8 bit shift |eft

¥ overlow is possikle in 16 bit addition

W gverlow is possible in 16 bit multiplication
W overlow is possible in 16 bit shift it

¥ possibly incarrect assignment

M pointiess integer comparison

¥ contralling expression is constant

v oK X Cancel |

% Tools_206

15.06.2021

Bild 6.2.2-03: Configure Project
Part 3 - Code Generation

Hier kdnnen Einstellungen fir den Chip und
den Compiler zur Generierung der Ausgabe-
Dateien vorgenommen werden. Die Einstel-
lungen werden wie angegeben vorgenom-
men. Besonders zu beachten sind:

Chip: ATMega88

Clock: 16 MHz

Program Type: Application
Data Stack Size: 256 bytes

Heap Size: 0 Bytes

Internal RAM Size: 1024 bytes
Bit Variable Size: 16

Use GPIOR>31 nicht gesetzt

File Output Format(s):

Formate der Ausgabe-Dateien (hier ist vor-
rangig das Format HEX fiir ein ausfiihrbares
Programm von Interesse).

Bild 6.2.2-04: Configure Project
Part 4 - Messages

Das ist die Liste Messages, in der man ange-
ben kann, welche Hinweise und Warnungen
man erhalten mochte.

Das Setzen bestimmter Warnungen kann
beim Testen sehr hilfreich sein, um unerreich-
baren Code anzuzeigen oder davor zu war-
nen, dass Variable deklariert sind, die gar
nicht benutzt werden.
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Bild 6.2.2-05: Configure Project
Part 5 - Paths

4 . Configure Project AVR_PB_LED.prj

C Compiler | Biefore Build | After Build |

]
Files

Code Generat\onl Libranesl Messages' Globally #define  Faths | . . . . i _
Hier kdnnen neue Pfade flr zusatzliche #in-

clude- und library-Dateien angelegt werden:

#include paths (one per line):

Chovawryine

#include paths (one per line):
fur globale Header-Dateien

Library paths (one per line):
fur Bibliotheksdateien

Fur die hier generierten AVR-Projekte wird
von dieser Moglichkeit kein Gebrauch ge-

Library paths (one per line): maCht

Chovavr2ilib

W DK x Qancell ? Help |

6.2.3 Arbeitsschritte zur Generierung eines C-Projektes

—lo| x|
‘@(_\)ﬂ w | k3 [ AvR_PB_LED durchsuchen @‘
| Datei Bearbeiten Ansicht E;tras%
Organisieren ¥  Freigeben fur ~  Brennen  Neuer Ordner = - _D 9
- Favoriten Name “ Grobe | Anderungsdatum | Typ |
« Nicht angegeben (14)
B Desktop Exe 15082012 21:13  Dateiordner
_ | Bibliotheken
‘Q‘: ALE Linker 15.09.2012 21:13  Dateiordner
A Computer List 15.09.2012 21:13  Dateiordner
€& Netzwerk Obj 15.09.2012 21:13  Dateiordner
[ systemsteuerung application.c 11KB 15.08.2009 14:17 C compier source file
i Papierkorb application.h 36KB 15.08.2009 21:34 C compier header fie
% AVR_PB_LED.prj 6 KB 16.09.2012 13:15 CodeVisionAVR Proj...
AVR_PB_LED.prj~ 6 KB 16.09.2012 11:32 PRI~-Datei
ﬂ AVR_PB_LED.txt 0KB 16.09.2012 13:15 Text Document
iomx8.h 46 KB 15.08.2009 15:08 C compier header file
macros.h 4 KB 15.08.2009 20:07 C compier header fie
main.c 6 KB 15.09.2012 21:58 C compier source fie
switches.h 4 KB 15.08.2009 20:09 C compier header fie
typedefs.h 9 KB 15.08.2009 20:13 C compiler header fie
| 14 Elemente
‘14 Elemente | | v

Bild 6.2.3-01: Ausgangslage zur Kompilierung - Stand der Dateien

% Tools_206

15.06.2021
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CodeVisionAVR \AVR_PB_LED\AVR_PB_LED-prj

Fle Edt Search Vew Project Took Settings Hep

DeS-HEACEE BERE.

EREIEE Y Y-R-1E]

AW 0-0 -0 0 8 B w B,

PN

IERES T AN

EEEE DN, k%m0,

EEETT BIEN-AL)

v mE 1 e BROs mMmE.

- Code Navigator © % (| % Code Information ¥ 3 &
=G CodeVisionAvR =0
=8 Project AVR_PE_LED & Fl) Funcions pioies’ mainc ) N
25 Notes £G main(voic) = e =
0 application.c 3
mainc 1
Bl Headers 4 501_AVR_G_Projext PB_LED
A List Files 3
B AVR_PE_LED ssm § main.c #* V1.1
[B AVR_PB_LED.st 7
B AvR_PB_LEDmap E
[ Other Files 9 ||| Projexs so1.. : Demonstration der Taster und LEDs auf dem Testboard
10/ || zusael ine
11| || Module. (*.c und +.).: application
12||| Benostigt: Testboard, 1203
13 rsion. ..
114 Compiler.. . CodeVisionAVR
15 amegase
16 : Juni 2009
17 . Alvin Lenck (ALE23) basierend auf dem Projekt PB_LED von Ude Jusrss
18
13
20| | |Dieses Projext stellt eine ipplikation zur Demonstration der Tester (Pushbottons) und LEDs auf dem Testboard der.
21| |Die Taster sind nicht entprellt!
22
23| |pie LEDI ist im Ruhezustand AUS und bei gedrueckter Taste SI EIN
24|||pie 1ED2 ist im Ruhezustand EIN
25| |pie LEDS toggelt beim Betastigen der Taste
26
21
28| ||In der Hesder-Datei application.h kosnnen die Definitionen fuer die Tasten und LEDs geaendert verden.
28| ||Die Definitionen sind hier wie folgt festgelegt:
30
a1 ATmegaig-Pins:
32
33 PC2 (kann in application.h geaendert werden)
3 PC3 (kann in application.h geaendert werden)
35 PC4 (kann in application.h geaendert werden)
36
37| |++* Taste
38 s1 PB3 (kann in application.h geaendert werden)
39| ||s2 PB4 (kann in application.h geaendert werden)
40 53 PB5 (kann in application.h geaendert werden)
aflles
2| |7
43 // Header-Dateien einfuegen:
| |
45| |include mapplication.n”
46
| |
18| |// Globale Variablen:
as| (/7
s0| uoe n;
51
52| (/7
53 //—-H mail
se| (/7
55 | void main (void)
56
57 tzen des System-Taktes (CPU-Clock), Ausschalten nicht benutzter Hardvare-Module
3 app_init(); // Initialisierung der Anvendung
59
60 /¢ Initialisieren der Tasten ( ) —
61 S1_INIT():
62 S2_INIT():
) sa_IT();
64
65 '/ Initialisieren der LEDs
6 LED1_DDR |- LEDL_BIT; 1-Pin auf Ausgabe
&7 LED2_DDR |= LED2_BIT; 2-Pin auf Ausgabe
68 LEDS DDR |= LEDS_BIT: Pin auf Ausgabe
69
70 /7 Alle LEDs
71 for (n = 3: n; n—-)
72 t
73 LED1_PRT |= LEDL_BIT; /7 LEDL
7 LED2_PRT |= LED2_BIT: /7 1ED2
75 LED3_PRT |= LED3_BIT; /7 LED3
76
77 delay ms(250); /7 250 ms Verzosgerung (1/4
78
79 LED1_PRT /7 LED1 suf AUS
20 LED2_PRT | // LEDZ auf AUS
81 LED3_PRT &= ~LED3_BIT; // LED3 auf AUS
52
e3 delay ms(200): // 200 ms Verzoegerung (1/5 Sekunde)
84 13
&5
a5 |||/
87| ||// Hauptsonleire
a8 |||/
83| || while (true) // Endlosschleife
90 i
91 // Wenn Taste S1 gedrueckt vird, dasn leuchtet LEDL
92 if (S1_PRESSED()
93 {
En LED1_PRT |= LEDI ] /# LED1 suf EIN
95 }
96 else
97 {
9 LED1_PRT &= ~LEDL_BIT: /7 LEDL auf AUS
99 i
hoo
101 // Wenn Taste S2 gedrueckt vird, dann schaltet LEDZ auf AUS
o2 if (S2_PRESSED())
hos 1
fos LED2_PRT &= ~LED2_BIT: /7 LEDZ suf AUS
jLos }
jLoe else
o7 {
hoe LED2 PRT |= LEDZ i // LED2 auf EIN
Lo }
hio
111 // Wenn Taste S3 gedrueckt vird, dann toggle LED3
112 if (S3_PRESSED())
L1 {
s LED3_PRT "= LED3_BIT; /¢ Toggle 1ED3
his
16 S3_WATT_NOT_PRESSED () ; // Warte bis Taste S3 losgelassen wird
L7 1
L1e I3
L19 }
L20 /7
o1
il | J_I
B Messages vZd|
B Erors | B wamings
119:98 | | Insert |Code Information may be incomplete, as the fie was not Compied yet

Bild 6.2.3-02: Ausgangslage zur Kompilierung - CVAVR (BildvergréRerunq)

% Tools_206

15.06.2021
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Die Ausgangslage fir die Kompilierung sind in einem C-Projekt die sog. Quell-Dateien. In diesem Pro-
jekt sind das:

e Das Hauptprogramm main.c

e Das Modul application.cincl. application.h
e Die Header-Datei typedefs.h

e Die Header-Datei iomx8.h

e Die Header-Datei macros.h

e Die Header-Datei switches.h

Aus ihnen entsteht in grundsatzlich 4 Arbeitsschritten das fertige "Kompilat", das hei3t die ausfuhrbare
* _hex-Datei:

1. Arbeitsschritt "Lauf des Preprozessors": Auswerten aller Anweisungen, die mit # beginnen. Das
sind Anweisungen, die ausschlieRlich fiir den Preprozessor bestimmt sind (u. a. Einfligen von Header-
Dateien, die mit #include "Ffile" in den Quell-Dateien aufgefiihrt sind.

2. Arbeitsschritt "Lauf des C-Compilers" zur Ubersetzung der in der Programmiersprache C ge-
schriebenen Befehle in Assembler-Anweisungen => * _asm-Dateien (dieses sind ebenfalls editierbare
Text-Dateien).

3. Arbeitsschritt "Lauf des Assemblers" zur Ubersetzung der Assembler-Anweisungen in Maschi-
nen-Befehle (Module im Objekt-Code) => * _a-Dateien und * . o-Dateien

4. Arbeitsschritt "Lauf des Linkers (Binders)" zur Verbindung aller Objekt-Module zu einem lauffa-
higen ausfuhrbaren Computer-Programm => * _hex-Datei

In CVAVR kann das C-Projekt sequentiell, d.h. in Einzel- bzw. Stufenschritten, generiert werden:

Project => Compile (F9) Dieser Schritt produziert die Objekt-Dateien fur den Linker. Die
Kompilierung wird nur fur die nach dem letzten Durchlauf veran-
derten Programm-Module durchgefuhrt.

Project => Build (Shift+F9) Dieser Schritt produziert ein neues Assembler-Quell-Pro-
gramm mit der Erweiterung *.asm wobei nur die veranderten
Quell-Dateien neu kompiliert werden. Wenn keine Fehler er-
kannt wurden, wird automatisch der Atmel-AVR-Assembler
aufgerufen, der die eben erzeugte .asm-Datei assembliert. Das
Ausgabe-File ist eine ausfuhrbare Programm-Datei mit dem For-
mat *_hex.

Project => Build All (Ctrl+F9) Vollstdndige Kompilierung/Assemblierung/Verlinkung aller
Quellen; Zusammenfassung aller Arbeitsschritte zu einem Ar-
beitsgang.

Da das Projekt bereits an anderer Stelle getestet wurde, sind keine Fehler (mehr) zu erwarten, so dass
sofort mit dem Schritt Build All (Ctr+F9) fortgesetzt wird:

CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LED.prj

File Edit Search View )Project Tools Settings Help

|

JBES'F‘EE B Check Syntax Y- E|5|EE//>K|&I5|@"@'@,,@_)|E-%+x.@|(@.))v
|ga = w0 gp pome (] "L Comple 9 |@@$vj@*@§va%%ﬁ%@,]?g\};|@v

| & 8 Gy [ 5 % Buid Shift+F9

Fg Code Navigator E %_FB_LED\main.c

E-5Y, CodevisionAVR | & Stop Compiad
=3 Project AvE_PB_ % Clean Up
L5 Notes A=

Bild 6.2.3-03: Project => Build All (Ctrl+F9)

Notes  mainc £
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Wenn die vollstandige Kompilierung fehlerfrei (aber wahrscheinlicht nicht kommentarlos !) gelaufen ist,
werden tUber dem Haupt-Fenster von CVAVR zwei Informations-Listen am Ende der Projekt-Generie-
rung offeriert. Sie zeigen die Ergebnisse fir die Kompilierung und die Assemblierung.

CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LED.prj ;‘EIiI

Fle Edit Search Wiew Project Tools Settings Help

DS HEACEC|AERS. -~ [innnx B|S[E

=/ H %] 0-w- -5 2B 8B,

HEppAw [RIRROLOSEEE|S BN, sks0. [sassa 296,

BRI ==
%: Code Navigator ¥ 7 (][4 Code Information Bl -~ PE_LEDVmainc
=¥ CodevisianAvR =0 mainc

Notes  mainc &3

601_AVR C Projekt PB LED

main.c ** V1.1

[ Project AVR_PB_LED =B Includes

5] Motes B applicationh (e /*

[ application.c = -FF Global/Static Variables 2

B wamings X n->Rd E

[ mainc =-F{) Functions 4

Bl Headers F0 main(void) 3

application h 6

7

g

B wamings

limits. b 11
B macrosh 12 enostigte Hardwars
megal 68_bitsh 13 VErsSion.....ee..

megaiBh 1
B

stration der Taster und LEDs auf dem Testboard

stellib.h il
string.h 18
B switches.h g
typedetsh 20| | |Dieses Projekt stellt eine Applikation zur Demonstration der Taster (Pusabottons) und LEDs auf dem Testboard dar.
ListFiles 21 Die Taster sind nicht entprellt!
A AvR_PB_LED asm 22
AVR_PB_LED It 23||||Die LEDI ist im Ruh
AVR_PB_LED map 24|||Di= LED2 ist im R
Other Files 25| ||pie LEDZ toggelt beim Betae
il . =
E Messages v Zd|
B Erors B Wammgsl
[\Warning: LyAVR_PB_LED\ioms h{d1), included from: typedsis h macro 'UMSELDT' was redsfined ﬂ
'Warning: LyAYR_PB_LEDYiomx8 h{42), included from: typedefs h: macro 'UMSELDD' was redefined
‘Warning: LiyavR_PE_LEDYomx8.h(43), included from: typedets.h: macro "UPMOT' was redefined
‘Warning: LiyavR_PE_LEDYomx8.h(44), included from: typedefs.h: macro "UPMOD' was redefined
‘Warning: LiyAvR_PE_LEDYomx8.h(45), included from: typedefs.h: macro "USBS1' was redefined
"Warning: LyAvR_PB_LEDYomxd h{48), included from: typedefs.h: macro 'UCSZ01' was redefined =
119:98 | | Insert |
Bild 6.2.3-04: Nach der Kompilierung mit Build All (Ctrl+F9) (BildvergroRerung)
X | i Information 2N X |

i Informafion
)
Compiler Ssemblerl

Compiler Assembler | -

Chip: ATmegais

Clack frequency: 16000000 tMHz
Frogram type: Application

Memory model: Small

Optimize for. Size

(s)printf features: int, width
(s)scanffeatures: int, width

Promote 'char' to 'int': Mo

‘'char' is unsigned: Yes

global 'const' stored in FLASH: Yes
i bitenums: Mo

Enhanced function parameters passing: Mo
Autormatic register allocation: Yes
Srart register allocation: Yes

Build: 1
15441 line(s) compiled

Mo errors
604 warnin@
Bitwariables size: 0 byte(s)

Data Stack area: 0x100to 0x1FF
Data Stack size: 256 bvtels)
Estimated Data Stack usage: 0 byta(s)

RaAM Global variables area: 0x200 to 0x204
RAM Global variables size: b byte(s)

Hardware Stack area: 0x205 to Ix4FF
Hardware Stack size: 763 byte(s)

Heap size: 0 byte(s)
EEPROM usage: 0 byte(s). 0.0% of EEPROM

Frogram size: 182 words (364 bytes), 4,4% of FLASH
Owards (0 bytes), 0.0% reduced by Code Compression

AVFRASKM: AVR macro assembler 2.1.30 (build 592 Mow 7 2008 12:38:.17)
Copyright {C) 1995-2008 ATMEL Corporation

LiavR_PB_LEDListyAWR_PE_LED . asm(1654): Mo EEPROM data, delet

ATmegads memory use summary [bytes]:
Segment Begin End  Code Data Used Size Use®

[cseq] 0x000000 0x00016c 326 38 364 8192 4.4%
[dseq] 0x000100 0x000205 0 & 5 1024 05%
[eseq] 0x000000 Ox000000 O 0O O 512 0.0%

Assembly complete, 0 errars. Q

Bild 6.2.3-05: Compiler-Meldungen

% Tools_206

Bild 6.2.3-06: Assembler-Meldungen
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Wenn man tiefer in die Materie eingestiegen ist, so ergeben diese Listen sehr aufschlussreiche Hinweise
zum Kompilat und den benutzten Ressourcen (Speicher-Belegungen). An dieser Stelle mdgen die Hin-
weise

No errors und Assembly complete, O errors.

geniigen. Sie zeigen an, dass das Projekt fehlerfrei kompiliert und assembliert wurde und ein ablauffa-
higes Objekt-Programm erzeugt wurde.

6.3 Einbinden von AVR Studio in den CVAVR

Der Compiler CVAVR ist daftir vorgesehen, mit dem Debugger vom AVR Studio ab der Version 4.13 zu
kommunizieren. Dazu ist es notwendig, die Lokalisation von AVR Studio, d.h. den Ordner-Pfad von AVR
Studio auf der System-Platte, der Anwendung CVAVR bekannt zu machen. Diese Lokalisation ist (unter
der Annahme, dass AVR Studio auf seinem "angestammten” Platz installiert wurde):

C:\Program Files (x86)\Atmel\AVR Tools\AvrStudio4\AVRStudio.exe

Der Eintrag in CVAVR wird im Meni Debugger Settings vorgenommen:

CodeVisionAVR - L:\AVR_PB_I| ED\AVR_PB I_ED prj
JFI-E Edit Search View Prc:-]ect Tools ngs Help

=T 5 (58 DE tERRSBE|SEE /0
Jﬁﬂﬂmﬁﬁ,m“t%mwﬁﬁm ERFSIETEIE S XNV
EEEIR TR Er R 1 0:buser

'\,

EE: Code Mawvigatar =R | % Cod i&‘ Programmer 2l |
=-5Y CodevisionAvR =03 & Terminal
o[ Project AVR_PE_LED B @j Includes
""" Motes o LB application.h 1+
=0 application.c - % Global/Static Varisbles ||| 2| ||-~-""-"""mmmm0-
=B Warnings X no R ||| -—---—-—--————-
_____ . main.c E|F'{} Functions 4 B e )
=~ . Headers L Y mainfvoid) a\\-------————————-
3 ﬁpp“CﬁtIDnh E R E S R EEE S EEE S F EE S F
chype.h my-----------—-—-—-—-
o B delayh =
El Bl iomxdh 9 Projekt £01.......

Bild 6.3-01: Debugger-Eintrag in CVAVR vornehmen

<, Debugger Settings il

Cebugoer: Iaﬁ.\fF’i Studio 4.19 j

Directory and Filename:  &» &
CAProgram Files xaEhAtmelAVE Toals\AvrstudiodaRStudio 'E‘gl

X Cancel ? Help |

Bild 6.3-02: Einstellen der Datei AVRStudio.exe

Settings => Debugger => Debugger Settings => Directory and Filename:
C:\Program Files (x86)\Atmel\AVR Tools\AvrStudio4\AVRStudio.exe
=> 0K
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Sollte AVRStudio.exe rEt an der vorgesehenen Lokalisation installiert worden sein, so kann sie mit

der "File-Such-Funktion" gefunden werden:
Debugger Directory and FileName il
Suchen in: I | AvrStudiod j e E
Name =~ |V| GriBe |V| Anderungsdatum |V| Typ
— Nicht angegeben (8)
CUIEEBESUCNE | bin 06.09.2012 21:49 Dateiordner
E Lodl 06.09.2012 21:50 Dateiordner
Desktop | edt 06.09.2012 21:49 Date_nordner
| resources 06.09.2012 21:49 Dateiordner
H | skins @ 06.09.2012 21:49 Dateiordner
Bibiothéken *AVRStud'lo.exe 3.223 KB 25.08.2011 21:05 Anwendung
ﬁP\uginManager.exe 55 KB 25.08.2011 20:58 Anwendung
I’ ® |xmiconvert.exe 284 KB 25.08.2011 20:59 Anwendung
Computer
1Y
d | [

Dateiname: Zé ﬂ Offnen
Dateityp: IExecutabIes(”.exe) LI Abbrachen |

Bild 6.3-03: Suchen der Datei AVRStudio.exe

Hinweis: Hier findet ein gleitender Ubergang zum néchsten Abschnitt statt. Man befindet sich scheinbar
noch in der Anwendung CVAVR. Denn aus dieser heraus wird der Debugger aufgerufen, der aber
schon Bestandteil des AVR Studio ist.

6.4 AVR Studio Debugger

Mit dem Debugger des AVR Studios kann man - bevor man den Objekt-Code des fertig kompilierten
Projektes in den Flash-Speicher des Mikrocontrollers tUbertragt - Schritt fur Schritt den Programmablauf
simulieren.

"PB_LED.prj

CodeVisionAVR - L: \AVR_PB_LED\A/,V"'V\?
J Fle Edit Search View Project | Tools Settings Hep

b eo-E @ @ S| & codewrardaVR  Shift+F2
CEEY T REREL 1000 o  siness
J%‘ﬂ ’E@H%%‘@Ch'\pgrogra Per  Shift+F4

RAB|E|EE/7|%0-0 88|88« a|H.
BN, e K%8 0. A XSD.|? 54O,

e Code Mawigator LR | & Terminal Shift+F5
=&Y, CodavisionAVR: {0 LCD Vision Shift+F6
=-[§ Project AvR_PB_LED
i 1% Motes e% Configure

42
43

r
// Header-Dateien einfuegen:

© @B wamings
Bild 6.4-01: Aufruf des Debuggers zum Projekt AVR_PB_LED
Tools => Debugger (Shift+F3) => 0offnet AVR Studio => File => Open File...(Strg+0)

Es startet AVR Studio (aus CVAVR heraus !):

Dabei wird ggf. das Startfenster mit einem Willkommensdialog ged&ffnet, wenn die Option Show this
dialog on open aktiviert war. Da nicht mit Assembler oder AVR GCC gearbeitet wird, sondern ein
AVR-Projekt mit CVAVR erstellt werden soll, wird das Hakchen bei Show dialog at startup entfernt -
und das Fensterchen erscheint zukinftig nicht mehr.

Es ist zu beachten, dass bereits einige Optionen voreingestellt worden sein kénnen, so dass das Abbild
von AVR Studio nach der urspriinglichen Installation anders ausgesehen haben kénnte.
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AVR Studio
97

Project Build View Tools

1 NewFile Strg+N

Debug Help

1C BRI MR ARE

i
EE]
¥
‘
a
g

|L_j Open File...

Close

% Strg+0 |

e TGO e

Al save Strg+S I =
Save As... |Value
. A save Al
2 L
=l 3| Print... Strg+P
3 ’ |
\| @ Print Setup...
g Address |Value ‘ Bits
<
[Z] suild ﬂmessage %Find in Files |p_=aBreakpoints and Trace.. |4 | | _>|
L CAP NU g
Bild 6.4-02: Offnen des Datei-Dialogs
- omen x|
—————————————————————

OO0 [ oommm &

v 23 | AvR_PB_LED durchsu... @‘

Organisieren ¥ Neuer Ordner = ~ [ ﬁ
Name “ | GriiBe | Anderungsdatum | Typ |
~ Nicht angegeben (25)
| Exe 23.09.2012 19:39 Dateiordner
| Linker 23.09.2012 19:39 Dateiordner
| List 23.09.2012 19:39 Dateiordner
| Obj 23.09.2012 19:39 Dateiordner
application.c 11 KB 15.08.2009 14:17 C compiler source file
application.cd 1KB 23.09.2012 19:49 CCI-Datei
application.h 36 KB 15.08.2000 21:34 C compiler header file
application.hci 1KB 23.09.2012 15:49 HCI-Datei
application.i 9KB 23.09.2012 19:49 C compiler lbrary fie
AVR_PB_LED.chi 1KB 23.09.2012 19:49 CBI-Datei

AVR_PB_LED.cof

AVR_PB_LED.fct 1KB
2 AVR_PB_LED.prj 6 KB
AVR_PB_LED.prj~ 5 KB
iomx8.h 46 KB
iomx8.hdi 11 KB
macros.h 4 KB
macros.hci 1 KB
main.c 6 KB
main.cci 1KB
main.i 9KB
switches.h 4 KB
switches.hd 1KB
typedefs.h 9KB
typedefs.hci 4 KB

23.09.2012 19:49
23.09.2012 19:49
23.09.2012 19:50
23.09.2012 19:40
15.08.2009 15:08
23.09.2012 19:49
15.08.2009 20:07
23.09.2012 19:49
15.09.2012 21:58
23.09.2012 19:49
23.09.2012 19:49
15.08.2009 20:09
23.09.2012 19:49
15.08.2009 20:13
23.09.2012 19:49

COFF symbolic debug file

FCT-Datei

Code\VisionAVR Project File

PRI~-Datei

C compiler header file
HCI-Datei

C compiler header file
HCI-Datel

C compiler source file
CCI-Datei

C compiler library file

C compiler header file
HCI-Datei

C compiler header file
HCI-Datei

Dateiname: [AVR_PB_LED.cof

=] |AilFiles ¢

[

Offnen Abbrechen
g 4

Bild 6.4-03: Suchen der COFF-Datei
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Die bendtigte COFF-Datei befindet sich im Verzeichnis Lz\AVR_PB_LED des Projekt-Ordners vom Bei-
spiel-Projekt AVR_PB_LED und hierher soll auch die Datei AVR_PB_LED.cof.aps abgespeichert wer-
den:

Save AVR Studio Project File x|
. 2" J\

( L I J @ j 7] I AVR_PB_LED durchsuchen \@J
Organisieren ¥ Neuer Ordner = - @
Name “ | Grobe Anderungsdatum | Typ | |

« Nicht angegeben (4)

Exe 23.09.2012 19:39 Dateiordner
Linker 23.09.2012 19:39 Dateiordner
List 23.09.2012 19:39 Dateiordner
Obj 23.09.2012 19:39 Dateiordner
Dateiname: I AVR_PB_LED_cof.aps <1 j
Dateityp: |AVR Studio Project Fils (*.aps) =
~ Ordner ausblendenl g Speichern | Abbrechen |
4

Bild 6.4-04: AVR_PB_LED.cof.aps speichern

Es dauert einen Moment, bis man die Debug-Plattform AVR Simulator fir den Mikrocontroller AT-
mega88 einstellen kann:

Select device and debug platform
rSelectdebug platform and device
Debug platorm: Device:
RP AR Dragan ATmegabdCl ;I
AvE OME! ATmegabdhil
% AR Simulatar ATmegal
= Q= AR Simulatar 2 ATmegadhlh
"Q ICE200
ICE4D 38
ICERD ATmegaits
JTAG ICE ATmegassP ]
JTAGICE mkll ATmegadiPA
ATmegaia
ATmegadHWwa
ATmegaflu2 =
[ Open platfarm opticns nexttime debug mode is entered
<< Back | [alEdt >3 |é Finish | Cancel | Help

Bild 6.4-05: Debug-Plattform fir den ATmega88 einstellen

Nach einer weiteren kurzen Verweildauer o6ffnet sich AVR Studio mit der fur das C-Projekt
AVR_PB_LED eingestellten Debug-Plattform mit zahlreichen Toolbars, von denen besonders hervor-
zuheben sind:

e Prozessor-Daten (Counter, Pointer, Register usw.)

e Die aktuelle Quell-Datei D:\AVR_PB_LED\main.c mit einem gelben Pfeil auf die erste aus-
fuhrbare Anweisung

e Ein-/Ausgabe-Werte (I/O View; Hardware-Ressourcen)

e Nachrichten Uber die laufenden Aktivitdten (Message Output)
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Jetzt "schiebt" man sich die Seiten der Felder so hin, dass eine verniinftige Ubersicht erscheint:

¢ File Project Build Edit ¥iew Tools Debug Window Help
NS0 4 00T THNAS AT Y Wa@ir aE 1A SEEENEHI L I GAEG
[tacedissbled <] L Ak TGO i ik e e
. 1/0 View v X
= Bl L:\AVR_PB_LED\main.c - ol x| - l—:|—|
ame Value - A |E] ¢ | ANALOG_COMPARAT ~
Program Cou... 0x000076
Stack P 0xD4FF woid main(vaid) Blsme |Va\us ‘
Xtac' s o 0x0202 + D AD_CONVERTER
pointer 4/ Getzen des System-Taktes (CPU-Clock), Ausschalten nicht b D ANALOG_COMPARATOR
Y pointer 0x0200 o> app_init(): ## Initialisii JBcrPU
Z pointer 0x0004 BYEEPROM
Cycle Counter | 6287 s Initislisieren der Tasten (Pushbuttons) 4
. 40000 M S1_INIT(): 4 SHEXTERNAL_INTERRUPT
szequ\:ﬂ:yh 1571.75 ’ STl =i
op Wt us S3_INTT(); Port B Dats Regist 0:00
SREG o a2 ] o ata Register x
Port B Data Direction Register 0x00
-1|Registers o Initialisieren der LEDs N
RO0 07 LED1_DDR |= LEDI_EIT: /7 Setze LEDL Port B Input Pins 0x00
LEDZ_DDR |= LEDZ_EIT: 4+ Getze LED2 BIE2PORTC ]
Eg; xgg LED3_DDR |= LED3_EIT: +/ Setze LED3 Port C Data Regisisr D00
RO3 000 s/ Blle LEDs 3-mal aufleuchten lassen {"Lampen-Test") PortC Data Direction Register  0x00
R4 000 for (n = 3; n: n--) PortC Input Pins 0x00
» F 22 PORTD
RO5 000 LED1 _PRT |= LED1 BIT: +# LED1 auf E 2251
RO8 0x00 LEDZ_PRT |= LEDZ_BIT: » LEDZ auf E B
RO7 0x00 LED3_FRT |= LED3_BIT: /< LED3 auf E 4
RO 0x00 + B TIMER_COUNTER_1
delay_ms(250): £7 250 ms Ver: 4 B TIMER_COUNTER_2
R09 0x00 T
R10 0x00 LED1_PRT &= “LED1_BIT: /7 LED1 auf Al N ::IUSARTD
R11 0x00 LEDZ_PRT &= “LEDZ_BIT: /7 LEDZ auf Al Had
LED3_PRT &= “LED3_EIT: /7 LED3 auf &l =+l £ WATCHDOG
R12 0x00
R13 0x00 delay_ms (200); /4 200 me Ver:
R14 0x00 3
R15 0x00
e
R16 0x00 "/ Hauptechleife:
R17 0x00 e e e
R18 0x00 while (trus) /7 Endlosschly
R19 0x00 {
## Wenn Taste 51 gedrueckt wird, dann leuchtet LED1
R20 0x00 if (S1_PRESSED(}) Name Address ‘Va\ua |B\ts
R21 0x00 ¥ DDRB 0x04 (x24)  x00 JOO0O0OO0O
R22 0x58 LEDI_PRT |= LED1_BIT; /7 LED1 auf E =pINB w03 (023) 00 OOOOOO00
R23 0x00 e ZPORTB 0x05 (x25)  Mx00 JOO00O0O00
R24 0x00 ¥ DDRC x07 (x27)  Ox00 1 OO0COO0CO
R25 0x00 LEDI_PRT &= “LED1_BIT: 47 LED1 auf Al 2PINC 006 (0x26)  0x00 M OOOOOCO
R26 0x02 2 PORTC 0x08 (x28)  Ox00 ' OO0COOCO
R27 0x02
R28 0x00 /7 Wenn Taste 52 gedrueckt wird, dann schaltet LEDZ auf AL
if (S2_PRESSED())
R29 0x02
R30 0x04 LEDZ_PRT &= “LED2 BIT: /< LEDZ auf Al
R31 0x00
else
LEDZ_PRT |= LED2_BIT: </« LEDZ auf E
s Wann Taste 53 gedrusckt wird, dann togyle LED3 (EIN*AUS_
if (S3_PRESSED())
{
LED3_PRT ~= LED3_BIT: /# Toggle LED _
[ L:\AVR_PB_LED\main.c 4
Loaded plugin STKS00
AVR Simulator: Please wait whie configuring simulator...
AVR Simulator: ATmega88 Configured OK
Loaded objectfile: L:\AVR_PB_LED\AVR_PB_LED.cof
< | ]
[E suild 0Message %Fimd in Files EJEreakpomts and Tracepoints
ATmega88  AVR Simulator Auto Stopped (ST 58, Call CAP NUM OVR

Bild 6.4-06: Debug-Plattform mit Quell-Datei main.c (Bildvergré3erung)

Mit der Funktionstaste F10 bzw. F11 vom PC kann man nun Schritt fir Schritt den Programmablauf
simulieren. Wenn man dabei den Cursor auf eine Variable positioniert, dann bekommt man den jeweili-
gen Wert angezeigt. Im Menlpunkt Debug kann man sehen was sonst noch so alles méglich ist. Hier
nur ein paar Hinweise der zahlreichen Mdglichkeiten des Debuggers:

Wenn man in CVAVR eine Anderung im Quell-Programm vornimmt, neu kompiliert und wieder nach
AVR Studio wechselt, dann merkt AVR Studio, dass sich die * . cof-Datei gedndert hat und fragt nach,
ob diese Datei neu geladen werden soll. Wenn diese Anfrage mit JA beantwortet wird, dann startet der
Debugger nach dem Neuladen wieder von vorne.

Wenn AVR Studio neu aus CVAVR heraus gestartet wird, dann kann ein vorhandenes Projekt unter
dem Menlpunkt Project => Recent Project Projektname wieder unkompliziert geladen werden.
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AVR Studio

: File Id View Tools Debug Help

RN Project Wizard DA MR e A EE
! [Trace New Project if_ i RN i “‘[2 r‘tZ T

Open Project

A save Project

Close Project

L

Recent Projects 1 AVR_PB_LED_cof.aps

2 L\ALEs_ASM_Progs\ALE_0002\ALE_0002.aps
3 L\ALEs_ASM_Progs\ALE_0001\ALE_0001.aps

Bild 6.4-07: Fortsetzen des Debugging nach einem Neustart

6.5 Flashen eines C-Programms in ein Mikrocontroller ATmega88

ISON

LESTI
10801

Wenn man in diesem Projekt beispielsweise auf PORTC klickt, dann kann man wahrend der schrittwei-
sen Programmausfihrung (mit F10) sehen, wie sich PC2, PC3, PC4 (entsprechend dem kurzen Auf-
leuchten der LED's) nach dem Reset verandern.

Das Programm AVR_PB_LED ist jetzt kompiliert und simuliert worden. Aber ein Test im "Wirkbetrieb"
ist natiirlich noch wichtiger. Dazu muss der Objektcode (das kompilierte Programm) in den Mikrocon-
troller (hier in den Mikrocontroller auf dem AVR-ALE-Testboard) geflasht werden und es mussen die
notwendigen Verbindungen zwischen den Pins hergestellt werden. Die Beschaltung ist identisch mit
dem Abschnitt 1.2 Beschaltung im Teil 601 - AVR_PB_LED:

Ké
ext.
16]15(14[13|12{11{10{ 9

H
2 [3 . g
a8 ] IS
oNC NC O
o NG NC O
0Cla / PBl e 5 r— PBO / ICP
SSs / OC1B / PB2 '16 13' PD7 / AIN1
oc2 / MOSI / PB3 s i PD6 / AINO
MISO / PB4 /] -13 "' PD5 / T1
sck / eB5| [ 1 - o PB7 / TOSC2
avee | | R '20 .3' PB6 / TOSC1
AREF o 5 GND
GND _ o = - +5V
ADCO / PCO o a PD4_/ XCK / TO
ADCL / PCl o o PD3 / INT1 b d
ADC2 / PC2 = 7 PD2_/ INTO
ADC3 / PC3 sk s PD1_/ TXD
SDA / ADCA / PCA et 7 PD0_/ RXD
SCL / ADCS / PC5 ahn 7 PC6 / RESET
ATmega a2
8/48/88/168/328 g
w
L "
| — \ N\ : H
JP3
100 10k 10k 10k 10k 10k
ULN2003 10pH
>—o| = | ] | |
P2 K8.1 K8.2 K8.3 K8.4
-

1| 2| 3| 4 5/ 6 7| 8

g i s e

Taste 1 Taste 2 Taste 3 Taste 4 RESET

IR

Bild 6.5-01: Beschaltung der LEDs und Taster (Bildvergréerung)
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Dann wird das Board mit seinem Netzteil mit Spannung versorgt.

Der ISP-Programmieradapter wird mit seinem USB-Stecker in einen freien USB-Steckplatz des PCs
gesteckt, in dem das neue Programm abgespeichert wurde.

Uberflussige Schaltkreise und die Stromversorgung wurden in dem Beschaltungsbild weggelassen.
AVR Studio wird nun erneut gestartet.

Dann wird die logische Verbindung zum CC2-AVR Programmer (ISP-Programmieradapter) hergestellt.
Die Einstellungen wurden ja schon im Abschnitt 4.3.2 Mikrocontroller-Einstellungen im AVR Studio
von Teil 204 AVR Studio vorgenommen, so dass man sich damit nicht mehr aufhalten muss:

AVR Studio

: File Project Build View Tools Debug Help
)G A VAN M AL S AREEEYWa
§|Trace[)isabled - iﬁ_&f_il m “\"[2 thFIlIT[I

B connect to the Selected AVR Programmer

Bild 6.5-02: Mit dem CC2-AVR-Programmer eine Verbindung herstellen

AVRISP mkII in ISP mode with ATmega88 - |EI |i|

‘Main  Program | Fuses | LockBits | Advanced | HW Settings | HW Info | Auto |
~Device

‘ Erase Device I

[v Erase device before flash programming [¥ Verify device after programming

~Flash
| Use Current Simulato/Emulator FLAEH bemony

@ InputHEXFile | =1 |

Program | Verify Read |

~EEFROM
¢ Use Current SimulatayEmulatar EEREOM bMemany

@ Input HEXFile I _l

Program | Verify Read |

~ ELF Production File Format

Input ELF File: | _|

Save From: [ FLASH [+ EEPROM [ FUSES [ LOCKBITS

Fuses and lockbits settings
must be specified before
Program | Save | saving to ELF

ol

.
Detecting on 'USE'"...
AVRISP mkll with serial number 0000A0012325 found.
Getting isp parameter.. SD=0x05 .. OK ¥

K

Bild 6.5-03: Objektdatei (*.hex-File) suchen
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g

A < - < -
Gl\_)vl | -\A\VR_PB_LED\Exe %é j ml Exe durchsuchen @‘
Organisieren ¥ Neuer Ordner = ~ [ @
& Sicherungs-LW 1UUL| Name “ | GroBe | Anderungsdatum | Typ

» Wechsel-LW2 160 ¢

- ExtVideo-LW 1000
= o KINGSTON (L:) @ AVR_PB_LED.hex \&3 2KB 23.09.2012 19:49 HEX-Datei

4 Nicht angegeben (1)

| ALEs_ASM_Progs
= | AVR_PB_LED

| Exe
é | Linker
| List
| Obj
@ Netzwerk
5 systemsteuerung
5 Papierkorb

=] [ H

Dateiname: | AVR_PB_LED hex N =] |Fiash Intel Hex Files ¢“hex; |

‘;Oﬁnen | Abbrechen |
A

i

Bild 6.5-04: Objektdatei 6ffnen

AVRISP mkII in ISP mode with ATmega88s -] x|

‘Main  Program |Fuses| LockBitsl Advancedl HW Settingsl HW Inﬁa' Auto |
~Device

Erase Device |

[¥ Erase device before flash programming [¥ Verify device after programming
~Flash
¢ Use Curtent SimulaterEmulator FLAEH kemory
@ Input HEX File |L:‘.,AVFE_F’B_LED\Exe‘.rAVFi_F’B_LED.hex @ I
Program | Verify | Read |
~EEPROM

| Use Curent SimulaterEmulator EEPROR emary

@ InputHEX File I _l

Program | Verify Read |

~ELF Production File Format

Input ELF File: [ _|

Save From: [¢" FLASH [v EEPROM [~ FUSES [~ LOCKBITS Fyses and lockbits settings

must be specified before
Program | Save |

saving to ELF
=
Detecting on 'USB'...
AVRISP mkll with senal number 0000A0012825 found.
Getting isp parameter.. 3D=0x05 .. OK LI

Bild 6.5-05: Programm flashen ==> und das Programm testen ==> alles O.K.
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